
Panda Antivirus: Guida Completa 
 

Questo manuale si compone delle seguenti parti: 
1) PARTE 1: istruzioni per eseguire il download dell’antivirus  
2) PARTE 2: istruzioni per installare l’antivirus  
3) PARTE 3: istruzioni per  configurare l’antivirus 
4) PARTE 4: istruzioni per consultare i report relativi all’attività dell’antivirus sul proprio pc 

 
PARTE1: DOWNLOAD DELL’ANTIVIRUS 
 

1) Il cliente riceve l’e-mail relativa all’attivazione del servizio. Tale e-mail può essere, a seconda del periodo in cui è stata avanzata richiesta di 
attivazione, in  

 
                                       ITALIANO                                                                                                               INGLESE 

 
 

 



 
 
 

2) cliccare sul link  http://mop.pandasecurity.com.  

              
 

 
 
 

 
 
 
 
 
Si aprirà la pagina web: 
inserire come indirizzo di posta elettronica il campo Login indicato nell’email 
ricevuta e la relativa password. 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 

 
 

3) accettare i termini di licenza del contratto spuntando l’opzione  
 
 
 
                                  
 
                                                                                                             
  
 
 
 
 
 
 
 
                                                                                                               
                                                                                              
 
 
 
 
 
                                                                                                                                         leggere la guida rapida e poi premere il pulsante Chiudi 

 
 
 
 
 
 
 
 
 
 



 
4) dal Menu scegliere Installazione e Impostazioni -> scegliere Utilizza il programma di installazione -> scegliere Scarica il programma di 

installazione 
 

 



 
5) salvare il file sul proprio computer 
 

Procedura per FIREFOX      Procedura per INTERNET EXPLORER 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
PARTE 2: INSTALLAZIONE DELL’ANTIVIRUS 
 

1) avviare l’icona facendo doppio click con il tasto sinistrodel mouse e seguire le seguenti immagini per l’installazione. 
 

 
 
 
ATTENZIONE: in caso di utilizzo di Windows Vista consentire l’esecuzione del file 
 
 
 
 
 
 
 
                     
 
 
 
 
 
 
 
 
 



 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Si potrà sempre monitorare l’installazione tramite il simbolo presente in basso a destra del monitor 

 
 
 
 



2) In caso di presenza di precedente antivirus, questi sarà rimosso. Verificare, in ogni caso, se il proprio antivirus è stato disintallato 
automaticamente nella relativa sezione a pagina 10 di questa guida. 

   
 

                  Nel caso di installazione del Firewall sarà richiesto di         
                  riavviare il computer.  

 
 
 
 
 

 
In caso contrario invece si avrà la seguente schermata: 

 
 
 

 
 

3) verifica della corretta installazione: selezionare Start -> Pannello di Controllo -> Installazione applicazioni 
 
 

 
 
 
 
 
 
 

4) effettuare l’aggiornamento: premere con il tasto destro sull’icona in basso a destra e poi Update 
 

 
 
 
 
 
 

 

Per verificare quando è stato effettuato l’ ultimo aggiornamento è semplicemente necessario passare 
con il mouse sul simbolo Panda in basso a destra del monitor.  

                                                           Apparirà una schermata come segue: 



 

 

CONTROLLI DA EFFETTUARE PRIMA DELL’ INSTALLAZIONE 

Verificare i requisiti del proprio computer 

Prima dell’installazione è raccomandabile verificare i requisiti che deve avere il computer sui cui si vuole procedere con l’installazione. Consultare la 
sezione requisiti da verificare. 

Verificare la presenza di altri antivirus sul computer 

E’ molto importante che prima di installare l’antivirus sul computer non ci siano altri antivirus installati. Molti di questi vengono rilevanti e disinstallati 
automaticamente durante la procedura di installazione. Se il proprio antivirus non è nella lista si prega di disintallarlo manualmente (Pannello di 
controllo > Aggiungi o Rimuovi Programmi) prima di procedere con l’installazione. 

Gli antivirus che vengono automaticamente disinstallati sono consultabili nella sezione relativa all’elenco degli antivirus automaticamente disintallati 

Chiudere le alter applicazioni durante l’installazione 

E’ consigliabile chiudere tutte le applicazioni durante l’installazione. E’ particolarmente importante con le applicazioni e-mail in quanto potrebbero 
causare errori durante l’installazione.  

REQUISITI DA VERIFICARE 

Requisiti per accedere alla webconsole 
- Browser:  
Internet Explorer 6.0 o successiva 
Mozilla Firefox 2.0 o successiva 
 
Per evitare errori con i certificati di sicurezza del browser utilizzare SSL 3.0 e abilitare TLS 1.0. Per abilitare queste opzioni: Tools > Options > 
Advanced > Encryption. 
 
- Network: 
Connessione Internet: diretta o attraverso una rete LAN. 
HTTP connection (port 443) 

Requisiti minimi per i computer sui quali deve essere installato l’antivirus 

Workstations 

- Sistema Operativo: Windows XP (32 and 64-bit), Windows 2000 Professional, Windows Vista (32 and 64-bit) 



- RAM: per la protezione antivirus: 64 MB, per il Firewall: 128 MB. 
- Almeno uno dei server o dei computer deve avere una connessione internet. 
- Processore: Pentium 300 MHz o equivalente. 
- Hard disk: Antivirus: 270 MB, Firewall: 180 MB, Antivirus + Firewall: 280 MB 
- Windows Installer 2.0 

Servers 

- Sistema Operativo: Windows 2000 Server, Windows Server 2003 (32 and 64-bit), Windows Server 2008 (32 and 64-bit) 
- RAM: 256 MB  
- Browser: Internet Explorer 6.0 o successivo 
  Almeno uno dei server o dei computer deve avere una connessione internet. 
- Processore: Pentium 300 MHz or equivalent. 
- Hard disk: Antivirus: 270 MB, Firewall: 180 MB, Antivirus + Firewall: 280 MB 
- Windows Installer 2.0 

Requisiti minimi per i computer sui quali deve essere utilizzato il distribution tool 

 
- Sistema Operativo: Windows Vista (32 and 64-bit), Windows XP Professional (32 and 64-bit), Windows 2000 Professional, Windows Server 2000,   

  Windows Server 2003 (32 and 64-bit), Windows Server 2008 (32 and 64-bit). 

- RAM: 64 MB  

- Hard disk: 20 MB  

- Processore: Pentium 300 MHz o equivalente 

- Windows Installer 2.0  

- Browser: Internet Explorer 6.0 o successivo 

- Accesso come utente Amministratore sul computer su cui è installato il tool di installazione 

 

Requisiti minimi per i computer sui quali l’antivirus deve essere installato tramite distribution tool 

-Disabilitare il Windows firewall o configurare l’eccezione File and printer sharing (Start > Settings > Control panel > Network connections > Local area 

connections > (right button) Properties >  General > Settings). 

-Disabilitare  Use simple file sharing (on Windows XP, Tools > Folder Options > View > Use simple file sharing). 

-Sui computer con Windows Vista che non sono in un dominio con Active Directory disabilitare l’UAC (Users Account Control): (Control panel > User 
accounts > Turn User Account Control On or Off > disabilitare la checkbox 'Use User Account Control (UAC) to help protect your computer). 

 

 

 



 

ANTIVIRUS CHE VENGONO DISINSTALLATI AUTOMATICAMENTE 

La seguente lista è valida per le seguenti installazioni: 

Products 
Panda Managed Office Protection 
 Operating Systems 
Windows 2000 Professional  Windows XP (64-bit Edition)  
Windows 2000 Server  Windows 2003 Server (64-bit Edition)  
Windows Vista (32-bit Edition)  Windows 2003 Server (32-bit Edition)  
Windows Vista (64-bit Edition)  Windows Server 2008 (32 bits)  
Windows XP (32-bit Edition)  Windows Server 2008 (64 bits)  
   

 Lista dei software antivirus che vengono rilevati e disintallati automaticamente: 

VENDOR   NAME OF THE PRODUCT 

 Avast  Avast! 4 Small Business Server Edition 

 AVG  AVG Internet Security SBS Edition 8 

  Anti-Virus SBS Edition 8.0 

  AVGFree v8 

  AVGFree v7.5 

  AVGFree v7.0 

  Computer 
Associates 

 eTrust AntiVirus 8.1 

  ESET 

 ESET NOD32 Antivirus 2.7.XX (2007) 

 ESET NOD32 Antivirus 3.0.XX (2008)* 

  F- Secure  F-Secure Protection Service for Business 

   Antivirus Client Security 7.1 

  F-Secure Internet Security 2009 

  F-Secure Internet Security 2008 

  F-Secure Internet Security 2007 

  F-Secure Internet Security 2006 

 Kaspersky  Kaspersky® Work Space Security 

   Kaspersky® Business Space Security 

  Kaspersky® Anti-virus 7.0 (with Windows 

Vista+UAC, it is necessary to desactivate UAC) * 

  
Kaspersky Internet Security 6.0 (with Windows 
Vista+UAC, it is necessary to desactivate UAC) * 

 
Kaspersky Internet Security 7.0 (with Windows 
Vista+UAC, it is necessary to desactivate UAC) * 

 
Kaspersky Internet Security 8.0 (with Windows 
Vista+UAC, it is necessary to desactivate UAC) * 

  McAfee  McAfee VirusScan Enterprise 8.5i 

   McAfee VirusScan Enterprise 8.0i 

   McAfee Internet Security Suite 2007 

  
 McAfee McAfee Total Protection for Home Users 
(Retail) 

  
 McAfee Total Protection Service(AKA McAfee Total 
Protection for Small Business or ASAP) 

  
 McAfee Total Protection for EndPoint (AKA McAfee 
Total Protection for Enterprise) 

   McAfee Total Protection 2008 

 Microsoft  Microsoft Live OneCare 

 PC  PC-Cillin Internet Security 2006 

 Sophos  Sophos Anti-virus SBE 2.5* 

   Sophos Security Suite 



 Trend Micro 

PC-Cillin Internet Security 2006  

PC-Cillin Internet Security 2007*  
 
 PC-Cillin Internet Security 2008* 

 Trend Micro Office Scan 7.5 

 Trend Micro OfficeScan 8.00 

 Panda  WebAdmin (all versions) 

 

 Panda ClientShield 3.01.10 

 Panda ClientShield 3.00.10 

 

 Panda FileSecure 7.01.10 

 Panda FileSecure 7.00.10 

  

 Panda for Desktops 4.00.XX 
 Panda for Desktops 4.01.XX 
 Panda for Desktops 4.02.XX 
 Panda for Desktops 4.03.XX 

  
 Panda for File Servers 8.00.XX 
 Panda for File Servers 8.01.XX 

 Panda for File Servers 8.02.XX 
 Panda for File Servers 8.03.XX 

   Panda Antivirus Pro 2009 

   Panda Internet Security 2009 

   Panda Global Protection 2009 

   Panda Antivirus  2008 

   Panda Antivirus+Firewall 2008 

   Panda Internet Security 2008 

   Panda Internet Security 2007 

   Panda Antivirus + Firewall 2007 

   Panda Antivirus 2007 

   Panda Antivirus Platinum 8.0 

   Panda Antivirus Platinum 6.0 

   Panda Platinum 2005 Internet Security 

   Panda Platinum 2006 Internet Security 

   Panda Antivirus + Firewall 2006 

   Panda Antivirus Platinum 7.0 

 

Se il proprio antivirus non è incluso nella lista provvedere alla disintallazione manuale prima di installare Panda antivirus 

* Kaspersky Anti-Virus 7.0 non verrà installato automaticamente se Windows Vista UAC è attivo 
* Trend Micro - PC-Cillin Internet Security 2007 e 2008 non può essere disintallato automaticamente con  Windows Vista x64 
 
* Trend Micro - PC-Cillin Internet Security 2007 e 2008 non può essere disintallato automaticamente with Windows Vista x86 con UAC actived 
* Kaspersky Internet Security 6. non verrà installato automaticamente se Windows Vista UAC è attivo  
* Kaspersky Internet Security 7.0 non verrà installato automaticamente se Windows Vista UAC è attivo 
 
* Kaspersky Internet Security 8.0 non verrà installato automaticamente se Windows Vista UAC è attivo 
 * ESET NOD32 Antivirus 3.0.XX (2008) non sarà installato correttamente per le piattaforme  64 bits. Non verrà installato automaticamente se 
Windows Vista UAC è attivo. 
* Sophos Anti-virus SBE 2.5 non può essere disintallato automaticamente con Windows 2008 

 

 



PARTE 3: CONFIGURAZIONE 
 
Programmare una scansione dalla webconsole 
Collegandosi alla webconsole porsi nella sezione  
 
IN INGLESE… 
Scheduled Scan nella sezione Installation and Settings -> Profiles -> General -> il proprio Profilo (solitamente Default) 
 
IN ITALIANO.. 
Scansioni Pianificate nella sezione Installazione e Impostazioni -> Profili -> Generale -> il proprio profilo (solitamente Default) 
 

 

Scegliere Nuovo (New) per una nuova scansione 

 

 

 

 

 

 

 



Eseguire una scansione dal proprio pc 

 
Sul proprio pc selezionare la cartella o il file che si desidera analizzare  e, selezionare nel menu che appare dopo aver ciccato con il tasto destro del 
mouse la voce “Scan with Panda End Point Protection” 
 

 

 

 

 

 

 

 

 

PARTE 5: RILEVAZIONE E REPORTISTICA 
 
In caso di rilevazione di virus/spyware sul pc dell’utente apparirà in temporale una segnalazione sulla parte in basso a destra del monito di questo tipo: 
 

 
 
Ciccando sulla i di informazione è possibile consultare il dettaglio della rilevazione: 
 
 
 
 

 



Oppure è possibile analizzare le rilevazioni a posteriori tramite la sezione Report della webconsole 

Accedendo alla web console nella sezione Reports si ha la possibilità di visualizzare diversi tipi di reports: 
- ESECUTIVO: riassunto degli oggetti rilevati le ultime 24h legate al traffico via rete 
- STATO: visione generale dello stato della rete 
- RILEVAMENTO: evoluzione degli oggetti rilevati negli ultimi 7 giorni 
 

 
 
 



 
 
 
I report posso essere relativi a: 

- STATO DELLA PROTEZIONE: riassunto delle versioni installate e dello stato degli aggiornamenti 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

- RILEVAMENTI: riassunto degli oggetti rilevati sulla rete 
 

 
 

 


